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Spotlight on Spotlight

Learn how spotlight can find any-
thing on your Mac instantaneous-
ly. This presentation actually covers
two features:

* getting the most from spotlight

* taking a looking at training
materials from Discover Your Mac.

Of course we will have a lively and
fun Question and Answer period
and maybe even take a look at
shareware, freeware, tricks or tips
from members. We also have door
prizes and a fun raffle planned.

Come and join in the fun, get
more out of your Mac. TMUG
meetings are always free and and
open to the public

Member Favorites are short pre-
sentations by members on their
favorite freeware or shareware
application, game, script, tool,
trick or tip. Members are invited
to step forward to present; there is
plenty of room on the schedule.

If you wish to be included on the
schedule please contact Allen Emory
at aemory@earthlink.net.

April 2006

Apple turns 30 — TMUG turns 20.

Hard to believe that Apple Computer has now been
around for 30 years. Just as amazing, TMUG has been
around for 20 years. (Or at least that’s our story and we
are sticking to it.) As Duane mentioned last month in this
column, TMUG is the only hardware-based user group
left in the Triangle. I find that pretty amazing.

As you know, TMUG elected a new executive committee
at the March meeting. I would be very remiss if I didnt
take time to thank the outgoing executive committee
members. So, hats off to Duane Reaugh, Melanie Crain
and Ruth Landa. The executive committee will miss you.
Also a big welcome to Chips Chapman, Alec Whittaker
and Cort Boylan, as they have been elected and accepted positions on the committee.
Finally, thanks go to Stefan Jeglinski for agreeing to continue on the board.

OK, as 'm writing this, I am hoping that Apple was going to make this big 30th
anniversary announcement and give me a break on what to write about. Well, a few days
have gone by and nothing big, but there have been a few interesting small things happen.

Apple has upgraded the performance on the 30" Cinema Display—both the brightness
and contrast have been improved. Also, some of the pro applications” universal binaries
have been released. Final Cut Studio (Final Cut Pro, Soundtrack Pro, Motion and DVD
Studio Pro). Apple has some pretty attractive cross-grade pricing. As you might know,
these application are no longer available individually, but only as a suite. So, the cross
grade pricing can be very attractive. From what I've heard, if you have Final Cut Pro 5,
you get to cross grade to the entire suite for $99. If you have Motion 2, cross grade for

$199. Not a bad deal.

Is it me, or do these releases make me think the desktop/PowerMac replacement is on
the way?

Oh, and, of course, thanks to our listserv and other places, looks like you will be able to
downgrade your Mac to running Windows. Good luck to those wanting (needing) to
do that. Looks like BootCamp and a copy of Windows XP are needed. I guess this is
the end of the road for VPC.

See you at the next meeting!
— Allen
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Now, here’s a sign you
don’t see every day!

Apple, the Apple logo, the MacOS logo and

Macintosh are trademarks of Apple Computers, Inc.,

registered in the U.S. and other countries.

From the Treasurer

New members: Renewals:

Linda & John Fisher of Apex

Don Cox of western Orange County

Melanie Crain renewed her membership.
Thanks Melanie!

Congratulations to our new officers, and many thanks to
our previous crew!

Alec Whittaker, right, is our
new Ist Vice President and

Chips Chapman, far right, is our
new 2nd Vice President.

Note the changes in the
TMUG Officers list to the left.

Thanks to Cort Boylan for the photos
of our new officers, here and on the
Ist page.

Keep Your Mac Running Smoothly with Take Control of Maintaining Your Mac
review by Adam C. Engst, ace@tidbits.com

Everyone agrees that regular maintenance is the best way to avoid nasty problems and
to ensure your Mac runs at peak performance, but it’s hard to know what you should
do and when to do it, and even harder to fit it into your schedule. If that describes
you, check out Joe Kissell's newest ebook, Zake Control of Maintaining Your Mac.

In it, Joe applies his commonsense approach to the task of maintaining your Mac.
You'll find out how to start on the right foot; what you should do daily, weekly,
monthly and yearly; and how to prepare for Mac OS X updates. Joe’s suggestions are
based on hard-won experience, so he covers not only what you should do but also
what you should know about commonly suggested panaceas that seldom actually
help. You'll also learn how to monitor your Mac’s health so you can detect problems
before they cause trouble, and find out where to turn if trouble does raise its ugly
head. Of course, opinions vary on some of these tasks, so the ebook contains conver-
sations with experts about what they do in particular situations. The ebook even
includes a one-page checklist you can post near your computer to remind you of
maintenance tasks. Also, don’t miss Joe’s interview with Chuck Joiner of MacVoices for
additional maintenance tips and utility advice.

hitp:/fwww. takecontrolbooks.com/maintaining-mac. html?14!pt= TRK-0032-TB820-
TCNEWS

hitp:/fwww.macvoices.com/archives/2006/641. html
Melanie Crain: I bought a copy of this eBook and have been impressed with it

from the start. With the book’s advice and with some self-discipline, anyone can
treat themselves to a Mac which has no self-inflicted problems.
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COMING OUT OF THE DARK

From iPod to MacBook Pro: A Switcher’s Tale

by Robert Movin, rmovin@gmail.com

By now most of you have read numerous MacBook Pro reviews
filled with technical specifications, startup times, benchmarks,
battery life, and counts of how many times an icon bounced
on the dock when an application is launched. This is not that
review. Rather, this is a tale of high drama, low comedy, antici-
pation, disappointment, and wonder. It’s the tale of a switcher
succumbing to Apple’s vaunted “halo” effect (and not the one
with the Master Chief). It’s the tale of how someone generally
satisfied with that “other” operating system running on a very
nice corporate laptop found himself refreshing live Jobsnote
transcripts every 30 seconds, breathlessly clicking through the
Apple Store, and dropping several thousand dollars on a shiny,
new, aluminum, Intel-based laptop. This is my tale.

Well, perhaps it’s not that dramatic, but hopefully I can pro-
vide an interesting perspective on the role of Apple in today’s
technology world, how great product design can overcome the
little annoyances that make switching far more difficult than it
should be, and how the MacBook Pro may not be perfect but
is absolutely worth the investment despite a few key shortcom-
ings. Before delving into the story and review I'd like to thank
Adam for allowing me to write this article under a pseudonym.
My job in the IT industry ties my name closely with my
employer, and a pen name allows me the extra freedom to
express personal opinions safely.

Early Days

I've never been overly religious about my operating system of
choice. In the third grade I started on Commodore PETs, used
my best friend’s Apple (mostly to play Wizardry), and owned a
Commodore 64. We loved that you could open up the Apple
and see the intestinal circuitry, but back then we were far too
timid to touch anything. I still remember the excitement when
the original Macintosh finally appeared in our school and I
delighted in explaining to the uninformed masses that the little
3.5-inch disk was, in fact, still a floppy (not a hard disk) despite
the lack of flop. Needless to say, I never dated until college.

It was back in college that Apple lost me. Even with the educa-
tional discounts, Apple’s products were out of my price range
(as were many food items). The operating system was no
longer the bastion of usability it once was, application support
was diminishing, and the enterprise world was slowly slipping
into the clutches of the boys and girls from Redmond. Worst
of all, my freshman roommate insisted on playing games on his
Mac late into the night. With the sound on.

When I started working in IT at a university I learned to hate
Macs—they were far more difficult to manage and integrate
into our existing network than other options. It was fine if you
went all Apple, like some of the labs did, but Macs back then
didn’t fare well in a mixed environment. Still, I admired Apple’s
early laptops, lusted after a Newton, and still held a soft spot
for Apple as a company.

Enter the iPod

Flash forward nearly a decade. I had just left my nice Archos
MP3 player on a flight back from Japan and it was gone for
good. I'd recently purchased a new desktop PC from Dell
despite pressure from Chris Pepper, a frequent TidBITS con-
tributor and close friend. We discussed how I just couldn’t
justify the thousands of dollars for a Mac with less processing
power than a $600 Dell, despite the Mac’s superior design. I
was happy with the music and image editing software available
for Windows, and due to careful management didn’t suffer the
performance or security issues that bedevil many home users.
Then I bought a third-generation iPod to replace the Archos
and started down the path that lead to the MacBook Pro.

The design of the iPod amazed me. I'd turn the lights off so I
could see the cool orange glow of the backlit keys. This is when
I realized that Apple created unmatched consumer experiences.
I had used every gadget and operating system available, but the
iPod experience was something I hadn’t felt since experiment-
ing with that first Macintosh. It was clean, usable, and didnt
feel like a bunch of parts and standards cobbled together in
whatever plastic case was lying around. I was hooked, and the
halo effect started. I also started a new long-distance relation-
ship and added an AirPort Express to my arsenal to support my
new multi-home lifestyle. Next came a Mac mini, priced lower
than my last car repairs and passing the future spouse test with
its diminutive size. Apple had finally produced a Mac I could
afford and easily integrate at home.

But what really surprised me was that Mac OS X blew me
away. You just can’t get the full feel of Mac OS X playing with
it at an Apple Store; it’s only when you use it every day that
you really appreciate its benefits. Stability was good, but not
that unusual for me since my Windows systems are pretty sta-
ble. It was the feel of Mac OS X, the tight integration across
applications (especially the iLife suite), the Unix command
prompt, and the wonders of AppleScript that finally sold me.

continued on page 4
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A Switcher’s Tale continued from page 3

I propped that little Mac mini on top of my Dell tower and
never looked back. It became our primary system. I started pro-
gramming in AppleScript. And next thing I knew it became my
home intranet server, managing our calendars, providing local
weather and traffic, distributing music, and even enabling me to
dabble in home automation. But the Mac mini always felt a bit
crippled—video conversion wasn’t worth the effort, iPhoto
crawled, and Microsoft Office lagged. It was time for something
better, but how could I justify yet another computer? As I was
no longer single, this wasn't just a rhetorical question.

Switching Chips

Intel was the answer. First came the announcement of Apple’s
move to using CPUs from Intel, which meant far more than
just a performance boost. The enterprise world is rapidly mov-
ing towards large-scale virtualization, abstracting an entire
operating system, configuration, and applications and running
them within another operating system, even on incompatible
hardware. Consider Microsoft’s Virtual PC, which makes a
“virtual” Windows system (called a “virtual machine”) think it
is running on a PC when it is in fact running on a Mac. If
you're not familiar with the inner workings of large I'T shops,
the virtualization revolution is just starting to hit, and the ben-
efits are immense. On the server side, virtualization enables
better segregation, simplified management, and improved
licensing (imagine running four different servers, each config-
ured separately, each isolated from the other, on a single hard-
ware system). On workstations, virtualization will enable enter-
prises to install a locked-down, secure image on pretty much
any piece of hardware while still allowing employees to destroy
the rest of the operating system with bad behavior. The enter-
prise is protected, support costs remain manageable, and users
still have the freedom to download spyware-laden weather
applications without causing problems. We're not there yet, but
it’s close.

As I'm sure many of you know, virtualization across hardware
platforms seriously degrades performance. There’s an extra
translation layer where every instruction needs to be converted
from one chipset to another. That’s why Virtual PC struggles
on even the fastest Power Mac G5. But with a consistent hard-
ware base—x86-compatible processors—virtualization becomes
a better option by reducing the number of translations needed
to get to the CPU. Using VMware (a Windows and Unix vir-
tualization product like Virtual PC) on that Dell of mine, I can
comfortably run two virtual machines and expect reasonable
performance. Apple was excluded from the virtualization game
because all versions of Windows and most versions of Linux are

locked onto Intel hardware. But with Macs also using Intel
CPUs we can expect equal or greater performance than run-
ning virtual machines on Windows. The practical upshot? I'll
be able to use a Mac for all my personal computing needs
while running a virtual image of my corporate system—with
all my corporate applications—in a little window in the corner
of my screen. Unless you rely on some odd heavy client-server
application, you'll be able to run Microsoft Outlook or Lotus
Notes natively in that virtual window, without compromising
corporate security or increasing support. In fact, support
becomes easier since that corporate image can be locked tighter
than the average user desktop and easily reset. Not that my
company supports any of this yet, but there’s always a way.

Switching to the MacBook Pro

And thus the last barrier to switch crumbled under the stomp
of the Intel bunny-suit. I started having problems sleeping. I
felt crippled when on the road and isolated from the elegance
of Mac OS X. Then came the Jobsnote with the MacBook Pro
as that “one more thing.” But could I justify it? With an
impending wedding (every geek gets his day!), a couple of
grand is no small commitment. I hemmed and hawed until my
fiancee asked if it was tax deductible. That was probably a mis-
take on her part, as I slammed the Buy button so hard I poked
a hole in my mouse. Weeks of anticipation passed, and finally
the slim MacBook Pro box arrived at my door.

Despite its clumsy name, the MacBook Pro is an excellent
piece of design and engineering. Unlike many TidBITS readers,
this is my first Apple laptop, and I love the PowerBook design.
The keyboard is compact yet easy to navigate, the ports are
well positioned, and it has a solid feel. The backlit keys and
ambient light sensor are a very nice touch (okay, so I'm a suck-
er for cool lights), as are the small LED on the Caps Lock key
and the charge indicator on the MagSafe power connector. The
built-in iSight camera is barely noticeable yet provides solid
image quality in a variety of lighting conditions. MagSafe
works exactly as advertised and is easier to plug and unplug
than a regular power cord. It’s just a good looking and good
feeling machine. But it isn’t perfect.

On the hardware side there are some definite shortcomings.
The MacBook Pro runs hot; it’s the hottest system I've ever
used. This morning the power key was uncomfortably hot to
the touch. The AC adapter is big, larger than an AirPort
Express. (All this makes me wonder a bit about Apple’s per-
formance-per-watt claims; all that heat has to be coming from

continued on page 5
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A Switcher’s Tale continued from page 4

somewhere.) The ExpressCard slot will undoubtedly be useful
in the future, but at the moment I have a stack of wireless
cards I can’t use (and still need to use). I hear a slight buzzing
when the LCD is turned on, although it’s usually not very
noticeable. Battery life is reasonable, but not exceptional;

I get only about 3.5 hours of normal use with wireless turned
on and the display slightly dimmed. Coming from the dual-
button PC world as I do, the single- button trackpad is a real
annoyance and needs that second button, but two-finger scroll-
ing works much better than I expected.

Again, the MacBook Pro’s hardware isn't perfect, but its far supe-
rior to anything in the PC world that’s similarly priced. In terms
of raw bang-for-the-buck, it will be hard to beat the MacBook
Pro, and it’s great to see an Apple laptop that's more competitive
than the over-priced systems from just a few years ago.

Software-wise, the MacBook Pro is nicely responsive—I won't
go into benchmarks. It boots in less than 30 seconds and com-
fortably handles whatever I've thrown at it so far. While I'm
writing this article in Mail, I'm also listening to iTunes, have
iMovie and iPhoto running in the background, and have both
Firefox and Safari active. Despite that, I don't feel like anything
is lagging, which wouldn’t have been true on my Mac mini.
The iSight works far better than I expected it would—iChat
video chats work just like those video chats in the movies, even
all the way to Australia (I checked). You know, the kind of
quality you never get on your expensive corporate system.

Not everything has been sweetness and light. On my very first
day with the MacBook Pro, I discovered the risks of jumping
onto a new platform. The custom VPN client for our corporate
network doesn’t run on Intel-based Macs, so I can’t use
Entourage to check my work mail. Fink is still updating to be a
universal binary; KisMAC isn’t quite universal yet; I can’t get
Tor running; and I had to download a special version of Firefox
(Deer Park). All these compatibility nits will fade in time, but
it’s frustrating that I might still have to lug my ThinkPad
around when traveling for work. Virtualization sounds close
using QEMU, but it’s not available yet. Some applications are
fine with Rosetta, but others can be painfully slow at times.
Microsoft Office runs faster than on the Mac mini, but I use
RapidWeaver for managing some personal Web sites and it can
crawl painfully when dealing with photos.

hitp://fink.sourceforge. net/
hitp:/lkismac.binaervarianz.de/

http://tor.eff.org/
hitp:/fwww.mozilla.orglprojects/deerpark/

http:/lfabrice. bellard. free.frigemu/
http:/lgemu.dad-answers.com/viewforum.php?f=6

hitp:/lrealmacsoftware.com/rapidweaver/

Despite these hardware and software shortcomings, I highly
recommend the MacBook Pro for most users. It’s one of the
best systems I've ever used, and it’s a pleasure to work on. Pro
users (the Adobe crowd) or system geeks needing specialized
applications might want to wait until the tools they need are
universal binaries, but for most users there will be few limita-
tions. I don’t have another PowerBook to compare it to, but
compared to my 1.42 GHz Mac mini, it’s like jumping into a
Corvette after years in a sturdy VW Bug (the old Bug). There
is a lot of talk on the Web about dual booting these machines,
but dual-booters might consider virtualization instead. Unless
you have special needs, you should be able to run your
Windows desktop inside Mac OS X as a virtual machine with-
in six months. Personally I don’t care about dual-booting; I'd
rather work in the superior look and feel of Mac OS X and just
open that Windows window when needed.

A Big Leap

Opverall, switching was a positive experience, but one filled with
small frustrations that would stymie the average user. As much
as I'd like to, I can’t even completely leave Windows for my
personal computing, much less work. You see, I'm one of those
users who falls between the elegant, yet totally closed, aspects
of the Mac OS X experience and the powerful, open-source
Darwin core.

On the proprietary side, Apple provides a clean, usable experi-
ence without the complexities normally involved in personal
computing. The operating system just works. The applications
just work, and more than that, they work together seamlessly.
Most of the consumer features (music, photos, video, chat,
email, calendar) are built in and easy to use, which helps main-
tain stability and security. On the open side, Apple gives us the
power of the Unix command line along with shipping versions
of open-source stalwarts like Apache, Samba, PHP, and various
programming languages. Drop to the command line in
Terminal, and you're in the world of consoles and scripts,
which, while it might not be easy or intuitive, offers unparal-
leled power in knowledgeable hands.

But it’s in the middle where Apple fails, and where switching
becomes daunting. Mac OS X is all or nothing. Either you
turn yourself over to Apple completely or gain the skills of a

continued on page 6
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A Switcher’s Tale continued from page 5

sysadmin. For example, I have yet to figure out how to con-
vince my Epson R200 to print borderless photos from iPhoto,
so I print all my pictures on my Windows box. My wireless set-
tings are lost between sessions, and although I know there must
be a way to store my home settings, it’s not readily apparent.
To print from my wireless print server I must use the com-
mand line. Mail and iCal stubbornly refuse to accept or send
Outlook-compatible meeting invitations, so I had to write a
custom AppleScript work. While .Mac has a Web-enabled
email interface, it lacks an interactive calendar, I can’t choose
what operating systems we use at work. I'm sure I will figure
out ways around these problems, but I could never explain
them to my parents over the phone.

What I've learned is if you go Apple, you better go all Apple,
all the time, unless you're a power geek and willing to spend
plenty of time on the details. Everything from Apple or built
for Mac works perfectly and easily, but be prepared for pain if
you fall into the middle. I agree with Steve Jobs’s mantra of
simplification, but not when simplification increases complexi-
ty. Every Windows user is used to two buttons on a mouse, so
stop trying to change those habits if you want us to switch. Let
us use Outlook/Exchange at work and still exchange appoint-
ments with iCal at home. Let us use Control-C to copy if we
want, right during setup.

I’'m slowly converting my entire family to Mac, but it’s hard to

BOOK REVIEW

FileMaker Pro 8, the Missing Manual
by Geoff Coffey and Susan Prosser

736 pp., Pogue Press/O’Reilly, 2005

ISBN 0-596-00579-2

Reviewed by Elsa Travisano

After bobbing along for years in the stream of incremental
updates to FileMaker Pro, I suddenly found myself washed into
the rapids by the sweeping changes introduced with FileMaker
7 and 8. Time for this old dog to learn some new tricks. Thank
goodness Pogue Press/O’Reilly has come to the rescue with
their first book on FileMaker, Filemaker Pro 8, the Missing
Manual. The booK’s chapters take you from creating your first
database to database design, creating basic and advanced lay-

move past their preconceptions. I'll probably have to pay for
their machines all myself. Luckily, my family members want to
use their computers for only a few activities, and these happen
to be the tasks the Mac excels at: music, photos, email, calen-
dars, Web browsing, and general family communications. I live
over 2,000 miles from my family, and the Mac will be the tool
that erases that distance. Video chats with the nephew who
(right now) barely knows me. Photocasting with my Mom.
Sleeping soundly at night knowing their computers aren’t
infected twelve ways to tomorrow. Even knowing my sister can
still play World of Warcraft with her gaming-addicted husband.
The just-released Intel-based Mac minis might be just the tick-
et, despite the slightly higher price, especially if I can find some
cheap iSights.

As for me, I'm firmly in the camp, if not the cult, of Mac. I
know I can work through most of the restrictions that frustrate
me so. Once I can get a virtual PC running my corporate life
in a window and after I can connect to my IR-enabled heart
rate monitor I'll be totally satisfied. As it is, I see myself leaving
the ThinkPad at home, even knowing it cuts me off from the
corporate lifeline. What the heck, I still have my Blackberry,
and maybe on that next flight I can edit a movie of our last
vacation deleting old email messages or watching a stuttering

DVD.

Switching is good. But it could (and should) be easier.

outs and reports, working with multiple tables and relation-
ships, working with calculations, scripting, dealing with securi-
ty, importing and exporting data, files and formats, sharing a
database and available developer utilities. Two very useful
appendices cover sources for getting help and a list of
Filemaker error codes.Filemaker Pro 8, the Missing Manual
removes the “grit your teeth” element of approaching database
design by using lively examples and real-world descriptions and
situations. The writing style is enjoyable throughout, and illus-
trations are ample and well chosen. Highly recommended.

Copyright ©2006 Elsa Travisano.
This article originally appeared in Newsbreak, the newsletter of
MUG ONE, Macintosh User Group of Oneonta, NY.
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Solutions to the Most Vexing Mac Problems

by Christopher Breen

Cursing the cursor

1 just purchased my first Mac after using Windows for many years.
1 would like to replace my arrow cursor with something bigger and
perbaps with a different picture. How do I do this>—Joe Robertson

Joe, better that I break it to you than a passing stranger in a
Wi-Fi coffee shop: most Mac users would no more replace
Apple’s elegant black arrow cursor with some pixelated sparkler
than we would slap rouge and lipstick on the Venus de Milo.

But que serd, serd. You can change your Mac’s cursor with the
help of Unsanity’s Mighty Mouse ($10). This haxie, or small
bit of code written to tweak OS X, allows you to customize the
Mac’s built-in cursors, turning your wait cursor into a wiggling
mermaid or a purple bouncing alien, for instance. Mighty
Mouse lets you choose additional cursor images from sites such
as ResExcellence. You can even import cursors designed for

Windows XP.

If, after reflection, all you want is a big cursor, change it by
going to the Universal Access preference pane, clicking on
Mouse, and adjusting the Cursor Size slider.

Mail time
How do I make Apples Mail display a 24-hour formar for
messages that appear in my inbox?—DBrian Shin

On the Clock, give an American Mac a 24-hour clock by using

the International preference pane’s Customize option.

You can make this happen through System Preferences. Open
the International preference pane, click on the Formats tab,
and click on the Customize button next to Times. In the
resulting sheet, select Short from the Show pop-up menu.
Click on the hour numeral in the text field below to reveal a
pop-up menu that begins with 1-12 (see “On the Clock”).
Choose 1-24 and click on OK. You've now created a Custom
region. When you next open Mail, you'll find that message
times are in the 24-hour format.

Maintenance must-haves

After many years of using Symantecs Norton Ustilities, I've got to
find another diagnostic tool for Tiger. The company’s Web site says
that Norton Utilities for Macintosh 8.0.3 is the last version
Symantec will release, and that it will not revise the suite for

OS X 10.4. What other application has features most like
Norton's’—Dave Brady

There are a variety of diagnostic and repair tools for the

Macg, including OS X’s First Aid (part of Disk Utility in
/Applications/Ustilities), Alsoft’s $80 DiskWarrior 3, Micromat’s
$98 TechTool Pro 4.0.1, and Prosoft Engineering’s $99 Drive
Genius 1.0.1. DiskWarrior is completely unlike Norton
Utilities, but that’s not a bad thing. TechTool Pro and Drive
Genius offer features similar to some of Norton’s components.
The comparison shakes out this way:

Disk Utility’s First Aid is free, and free is good. You can boot
from your Mac OS X installation disc and run Disk Utility to
try to repair your startup drive. Doing so isn't always effective,
but it can’t hurt.

DiskWarrior does one thing, but that thing is crucial: the pro-
gram repairs low-level hard-drive corruption with a skill no
other utility can match. Every Mac user should have a copy of
it. TechTool Pro, on the other hand, performs many services.
It tests your Mac’s hardware components—RAM, processor,
and FireWire and USB ports, for example. It also performs
many of the tasks Norton Utilities does—repairing corrupt
volumes, protecting files from accidental deletion, and
recovering data if the drive goes kablooey.

Drive Genius also performs a variety of chores, many of which
focus on disk functions. For instance, you can use it to opti-
mize your drive, much as you could do with Norton’s Speed
Disk. You can use it to expand or shrink disk partitions with-
out reformatting your hard drive. Drive Genius will also clone
volumes and check the integrity of your hard drive. As for
Norton Utilities-style repair, in addition to repairing permis-
sions, Drive Genius will attempt to rebuild one of a volume
database’s trickier objects, the Catalog B-tree (something
Norton never did well). And like Norton, Drive Genius allows
you to edit data sectors, something other utilities won't do.

I wish I could say “Get this one and you're done,” but I'd be
doing you a disservice if I did. All of these utilities have some-
thing to offer. If I had to prioritize their helpfulness, I would
recommend DiskWarrior for its one really good trick, Drive
Genius for its all-around drive- maintenance and data-repair
goodness, and finally TechTool Pro for its repair and data-

recovery charms. .
continued on page 8
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Solutions continued from page 7

Making your (Power)Point

I need to create a Microsoft PowerPoint presentation that includes
QuickTime videos for someone who uses Windows. More than one
person will use the presentation, so I don't want to assume they all
have QuickTime Player for Windows. Whats the best way to han-
dle this?—Jan Bobbett

Wonderful as Apple’s QuickTime is, it’s not on every Windows
PC. To make sure Windows users get the most from your pre-
sentations, convert your QuickTime movies to either AVI or
MPEG-4 format—both of which will play within a PowerPoint
presentation on a Windows computer. Then embed those
movies in your presentations.

To convert the movie files, open them in QuickTime Player
Pro ($30) and choose File: Export. In the resulting Save
Exported File As dialog box, choose either Movie To AVI or
Movie To MPEG-4 from the Export pop-up menu.

Movies exported at the default AVI export setting don’t look all
that great. To improve their appearance (although you’ll also
increase their file size in the process), click on the Options but-
ton in the Save Exported File As dialog box, and then click on
the Setting button in the Video portion of the AVI Settings
window that appears. In the resulting Compression Settings
window, move the Quality slider up to High or Best.

Be kind to your PC-using colleagues. When creating
PowerPoint presentations, export embedded QuickTime
movies in a format that’s compatible with Windows PCs.

If youre using MPEG-4 instead and are unhappy with the look
of the default export, click on the Options button in the same
Save Exported File As dialog box. In the MPEG-4 Export
Settings window, make these changes: choose MP4 from the
File Format pop-up menu, and select MPEG-4 Basic from the
Video Format pop-up menu (see “Special Export”). If the
movie’s frame is too large to fit your presentation, use a smaller
image size when you export the movie—change it from 640 by
480 to 320 by 240 for standard QuickTime movies, for exam-
ple, or to 320 by 180 if it’s a DV movie (DV movies have a
different aspect ratio). Doing so will reduce not only the
movie’s dimensions but also the amount of storage it requires
(thus making your PowerPoint package a little more easily
transportable). Set the Frame Rate pop-up menu to Current
and the Key Frame option to Automatic.

By default, the Data Rate field is set to 64 Kbps, which is really
low if you want to maintain the quality of the original video.
You may need to play with settings in this field to get it right.
I've found that a setting of 1,000 Kbps or higher gives me
quality that closely matches the original movie’s. I wouldn’t use
such a high rate if I were streaming video across the Internet,
because all but the fastest connections would choke, but for a
PowerPoint presentation on a hard drive, it’s fine.

Offline site seeing

Is there an easy way for me to download an entire Web site so that
1 can view its contents even when my Mac is not connected to the
Internet? That way, I could jump on my next flight, launch Safari,
and then browse the fully downloaded pages.— Tyler Moynihan

Second Site. Want to catch up on your reading when you don’t
have Internet access? To view just a single Web page offline, use
your browser’s File: Save As command.

There are several ways to suck out the contents of a Web site
and store it locally. If you simply desire a single page, use your
browser’s File: Save As command to save it as a Web page, or a
Web archive in Safari- speak (see “Second Site”). Once the
page and its contents download, you can read it when your
Mac’s not connected to the Internet.

If you'd like to grab more than just the page you're viewing,
you must turn to other tools, such as Microsoft’s free Internet
Explorer. Use this to navigate to the site you want. Then
choose File: Save As and make sure Web Archive appears in the
Format pop-up menu at the bottom of the Save window. Click
on the Options button, select the Download Links option, and
tell the program how many levels deep youd like it to save. For
example, two levels would save the home page and any pages
on that specific site to which the home page links. Click on
OK and then on Save. Internet Explorer will download the
Web site. To read it later, just open the Web archive.

Rick Cranisky’s SiteSucker (free [donations accepted]) is anoth-
er good option. In addition to allowing you to set the number
of levels it downloads, SiteSucker lets you queue up sites so you
can easily grab a number of them. And then there’s Limit Point
Software’s Blue Crab ($25). It offers more-extensive options
than Internet Explorer or SiteSucker— for example, you can
instruct it to download HTML files only, to skip images, or to
grab pages exceeding a certain number of kilobytes. You can

continued on page 9
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Solutions continued from page 8

even configure it to enter login information for protected sites.

If you want an even more complete solution and are willing to
pay for it, check out Soft Chaos’s $80 Webstractor ()—a utility
that, among other things, can automatically capture Web pages
as you browse.

Ready for the worst

One day, you just might waltz up to your computer, press the
power switch, and stare in dumb horror as your Mac displays a
flashing folder, offers a plain blue screen, or does little more
than whir. It makes sense, then, to have a troubleshooting drive
at the ready that can help you repair your ailing machine.

Your System Discs The good news is that you already have an
emergency boot disc: the Mac OS X CD or DVD that you
bought or that came with your Mac. Insert one of these and
hold down the C key at startup to make your Mac boot off the
disc. Then use the disc’s copy of Disk Utility. (If you're using
the Tiger installation disc, choose Utilities: Disk Utility and
then click on the First Aid tab when Disk Utility launches.)

Commercial Troubleshooting Utilities 1f you own a utility such
as DiskWarrior, TechTool Pro, or Drive Genius, these also come
on bootable discs. Use them as you would your system disc.

FireWire Drive You can create a bootable troubleshooting
device that, because it can hold multiple repair utilities, exceeds
the capabilities of an OS X installation disc. For instance, if
you have a FireWire hard drive, it can probably do the job.
(Not all FireWire drives can boot OS X; see our review of
FireWire hard drives)

If the drive has enough capacity, duplicate your Mac’s current
startup drive using Mike Bombich’s Carbon Copy Cloner ($5).
Any troubleshooting or repair utilities you have on your start-
up drive will work from the FireWire drive. On the other
hand, you can create a fresh emergency drive by installing a
clean copy of Mac OS on the FireWire drive and then
installing your troubleshooting or repair utilities on it.

When choosing an emergency FireWire drive, consider one that
you can easily slip into a pocket or pack in a computer case—
for instance, LaCie’s $240 Mobile Hard Drive or Other World
Computing’s $250 Mercury On-the-Go (both ; see our latest
review of portable FireWire drives). Such a small drive will
prove a useful companion both in your office and on the road.

Older iPod Do you have an older iPod (first through fourth
generation)? It can also boot a Mac when attached to that Mac’s
FireWire port. (Sorry, current iPod models can’t.) If the iPod has
about 5GB to spare, you can install a bootable version of Tiger
on it, as well as our troubleshooting utilities. This is a very
handy way to lighten your carry-on bag when traveling: all you
need is your iPod for both tunes and emergency protection.

Note that the iPod was not designed to be a primary startup
drive. It has no vents, and the heat buildup from running its
drive constantly will likely shorten its life. But I've successfully
booted an iPod to quickly repair a misbehaving Mac without
apparent mishap.

Tip of the month

Bring bookmarks into Firefox: Your review of Web browsers
(November 2005) firmly convinced me to switch from
Microsoft’s Internet Explorer to Mozilla’s Firefox. However, the
Import wizard in Firefox 1.0.7 will not import bookmarks
from Internet Explorer. I finally found a quick way to do this
crucial task.

Choose Bookmarks: Manage Bookmarks, and then choose File:
Import. Make sure that the From File option is enabled, click
on Next, and in the resulting Import Bookmark File window,
navigate to the Explorer folder (/ your user folder/
Library/Preferences/Explorer). Select the Favorites.html file and
click on Open to import the bookmarks.—Henry Francis

You can also use this technique to import your Explorer History
file as bookmarks. Simply choose History.html rather than
Favorites.html in the Import Bookmark File window.—Ed.

Senior Editor Christopher Breen is the author of Secrets of the
iPod and iTunes, fifth edition, and The iPod and iTunes Pocker
Guide (both Peachpit Press, 2005).

Find Chris’ books at www.amazon.com and www.peachpit.com.
Get special user group pricing on Macworld Magazine!
http:/fwww.macworld.com/useroffer
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SO YOU WANT TO BURN A CD?

Burning Down the Disc
by Adam C. Engst, ace@tidbits.com

Sometimes easy things turn out to be more involved than you
initially anticipated. Recently I wanted to burn a few CDs con-
taining the full Take Control library for a user group raffle. Pop
a blank CD into my Power Mac’s SuperDrive, let it mount in
the Finder, drag the files over to it, and click the Burn button
in that window. What could be easier?

Not much, if—and it’s a big IF—I didn’t care about user expe-
rience, in particular, what the window looks like when the user
double-clicks the CD icon on the Desktop. Obviously, if the
user views my CD in a column-view Finder window, I have no
control at all, and that’s fine. But in the event that someone
does double-click my CD’s icon in the Finder, I'd like it to
open to a well-laid out window. And heck, why should users
have to open the CD manually? If they insert it, it’s a pretty
good chance they want to open the window. All this, reason-
able as it might seem, turns out to be easier said than done.

With 31 ebooks and 3 folders for the Dutch, German and
Japanese translations, icon view doesn’t work well, leaving list
view as the best option. But with 34 items in the folder, the
default window is nowhere near large enough, and since some
of our ebooks have fairly long titles, the name column isn't
wide enough either. It’s trivial to adjust the window size and
column widths appropriately, but that’s where the fun begins.
Follow along with my quest for the perfectly burned disc to
learn the ins-and-outs of some common tools and approaches.

Just Burn It

The first and most obvious technique, as I noted before, was
simply to pop a writable disc into my SuperDrive, drag the
files and folders over to it, arrange the window as desired,
name the CD, and click the Burn button in the Recordable
CD row at the top of the window. The only problem is that
the Finder ignores the layout of the window entirely, resorting
instead to the default window size and icon view. Utterly use-

less. I've filed a bug with Apple.

Hot Folders

In Mac OS X 10.4 Tiger, there’s another way: the burn folder.
Choose File > New Burn Folder, and the Finder creates a spe-
cial burn folder that makes it easy to burn multiple identical
discs (in fact, when you burn a single disc, the Finder asks if
you want to create a burn folder to simplify the task of making
more). I thought that perhaps giving the burn folder the prop-

er layout would transfer that layout to the eventual CD. I was
wrong. Burn folders work in exactly the same way as burning
one-off discs, and they ignore any changes the user may have
made to the window size or layout. To my mind, this is even
more problematic, since the entire point of a burn folder is to
ease the process of making multiple copies, and once multiple
copies are involved, it seems all the more likely that window
layout would become important.

Disk Utility

Clearly, I needed another way. My next thought was to create a
disk image (a file that can be mounted by Mac OS X as though
it were a real disk of some sort) containing my files and with
its window laid out the way I wanted. Using Apple’s Disk
Utility, I created a disk image of roughly the right size, mount-
ed it, copied the files to it and set its window layout appropri-
ately. Then I selected it in the lower part of the drive pane in
Disk Utility, and clicked the Burn button in the toolbar. A
minute or two later, Disk Utility reported success, and indeed,
when I opened the window, it looked just the way I wanted.
Yay! Now if only there was a way to make it open automatical-
ly. After asking some smart friends, I learned that the following
Unix command, properly modified for the name of the disc
(the quotes are necessary if there are spaces in the disc name)
and invoked before burning, twiddles things such that the CD

window opens automatically. Success!

pseudo-bless folder “/Volumes/discName”-openfolder
“/Volumes/discName”

But as much as the process worked, it was a bit clumsy to per-
form, what with blessing the mounted disk image so it would
open its window automatically. Also, I need to add new ebooks
to the disk image periodically, so it has to be large enough to
hold them. When creating disk images, it didn’t seem to matter
if I chose a normal read/write image, or a sparse image. Sparse
images are more interesting, though, since they can be any size
virtually, but take up only as much space on disk as data is
contained within them. In other words, I could create a 650
MB sparse image, copy 62 MB of data to it, and have the disk
image file take up only 62 MB on my hard disk. The unfortu-
nate downside is that even when burning the sparse image,
Disk Utility must still burn the entire 650 MB, which takes a
long time. Given how much longer it takes to burn 650 MB
instead of 62 MB, it’s worth recreating the disk image every

continued on page 11
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SO YOU WANT TO BURN A CD?

Burning continued from page 10
so often when I run out of room instead of using a large sparse
image.

Nonetheless, I had a full workable solution that could perhaps
be automated somewhat with iKey, and one that used only free
tools. But perhaps there was an even better way.

Toast 7 Titanium

Next, I looked to Toast 7 Titanium, the popular disc-burning
software from Roxio, to see if it would provide a better answer,
since data CDs are almost the least of its capabilities. The most
obvious way of using Toast was an improvement over the
Finder, but not quite there. I dragged my files into the Data
tab, selected the Auto-Open Disc Window checkbox in the
Formats drawer, clicked the More button in the Formats draw-
er to access additional options, selected List View, and then
burned the disc. I couldn’t see how Toast could possibly know
what size to make the window, and indeed, it wasn’t the size or
layout that I wanted.

http:/fwww.roxio.com/en/products/toast/

My next thought was to try a disk image. Toast can make its
own disk images. Just choose File > Save as Disk Image after
you've dragged the files and folders you want into the Data
tab, but burning the disk image ran into exactly the same
problem as before—the correct view, but no memory of
window size or layout.

While perusing Toast’s online help I ran across mention of tem-
porary partitions, which I could create by choosing Utilities
Create Temporary Partition. Once created and named, I was able
to copy the files I wanted to it, arrange the window the way I
wanted, and burn it to a CD successfully using the Copy tab,
selecting the CD/DVD Copy radio button, and choosing the
temporary partition from the Read From pop-up menu. Yes!
The only slight downside was that Toast didnt provide the Auto-
Open Disc Window option, as it had for creating a Data CD.

The Unix command above worked fine when burning via Toast
as well, but I turned to Toast expert John Acree at Roxio to see
if Toast had a better approach. John told me that once I had
created my temporary partition I should, instead of using
Toast’s Copy tab, switch to the Data tab, drag the mounted
partition into the Data tab, select the Mac & PC radio button
in the Formats drawer, make sure the Auto-Open Disc
Window checkbox was selected, and then burn. It worked like
a charm, and even better, although I had made my Toast tem-

porary partition 650 MB (roughly the size of a CD), the disc
that Toast burned contained only the 62 MB of actual data.

But if the temporary partition was truly temporary, it wouldn't
do me any good, since I didn’t want to recreate it each time.
Toast has an answer to that as well. By default, upon quitting,
it asks if it should delete the temporary partition, and when I
clicked the Don’t Delete button, I was left with a Toast disk
image in my Documents folder. (Toast’s preferences provide a
setting for the location of these “converted items”; oddly, my
copy of Toast ignored that setting and always stored them in
my Documents folder.) And indeed, double-clicking this Toast
disk image file opened it in Toast’s Copy tab, where I could
click the Mount button to mount it, then switch to the Data
tab, drag the mounted volume in, and burn. Toast can also
install a Mount It contextual menu item that mounts disk
images directly.

So my Toast solution was slightly better than my Disk Utility
solution at this point, since it didn’t require dropping into
Terminal to invoke a Unix command. But I was still going to be
wasting 650 MB of hard disk space to store Toast’s disk image,
even if I had only 62 MB of data. I could make the temporary
partition smaller, but after all, saving space on disk is what
sparse image files are for. On a hunch, I created a 650 MB
sparse image file in Disk Utility, mounted it normally in the
Finder, adjusted it as I wanted, and then dragged the mounted
disk image to Toast’s Data tab and burned. Perfection at last!
Now I had a small disk image that I could mount easily in the
Finder by double-clicking, add to any time, and, with a quick
drag-and-drop, burn quickly and exactly as desired in Toast.

Parting Thoughts

The Finder turns out to be fairly poor at remembering window
layouts for disk images. To get a window to retain its layout, I
had to set it, close the window, open the window again, set the
layout again (the window had always shrunk slightly) and close
and re-open again. It’s not a big deal, but it would be nice if
the Finder could remember a disk image window layout in one
step. I filed another bug with Apple.

I also looked at FileStorm, from MindVision, which simplifies
the task of creating discs for distribution; it has a slew of
options for background images, icon positioning, automatic
window opening, and so on. I couldn’t use FileStorm for my
CD, since my 34 items really needed to be shown in list view,
and FileStorm is designed for icon view.

continued on page 12
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Burning continued from page 11

http:/fwww.mindvision.com/filestorm.asp

Lastly, it’s entirely possible that this whole problem is merely
additional evidence of my obsessive-compulsive battle with
window positioning. Back in 1996, I wanted to include a CD
of software with the fourth edition of my “Internet Starter Kit
for Macintosh” book, so I bought a CD burner to make the
CD. The only problem was, as you might expect, that I could-
n’t get the window position and layout to stick the way I want-
ed, and in fact, they were different every time. This happened
right at the deadline of a project that had been fraught with

TIP ABOUT USING INTERNET ARCHIVE’S FREE WEB HOSTING

Do you have some videos you've created that youd like to
make available for the world to see? Do you own all the rights
to the video? (i.e. Are the music and images in the video not
copyright by someone else?)

Then the free web hosting on the Internet Archive is a good
choice.  htp:/fwww.archive.org

As an example, here is a 52-minute (400 megabyte)
QuickTime file that VMUG member Phil Shapiro recently
uploaded to the Internet Archive using Cyberduck.

http:/fwww.archive.orgl/details/multimediastorytelling
hitp:/lcyberduck.ch/

Using a cable modem, this 52-minute video took about 3
hours to upload to the Internet Archive. If you have Verizon’s
fiber optic service, you could probably upload this video in
about an hour (or less.)

Using a dual-processor G5 PowerMac, this video took about
40 minutes to export from iMovie, using Share on the File
menu.

All this is to say that it’s entirely possible to shoot a video, edit
it and upload it to the Internet Archive all on the same day. It
takes about a day for the Internet Archive to release videos that

have been uploaded.

troubles from the very start, and after hours of failed attempts,
I grew so angry at the entire situation that Tonya called our
friend Chad Magendanz (author of the late ShrinkWrap disk
image utility) to come calm me down before I broke some-
thing. At the time, Chad was working on Microsoft’s CD
titles—Encarta, Cinemania, Music Central, and so on—and he
had lots of experience with mastering CDs. Although he wasn’t
able to solve my problem, he did manage to help me cool
down and finish off the disc. We've come a long way since
then, but it seems that some problems have managed to survive

all the changes.

You can always go back and edit the description of the video
from a link at the bottom left of the screen describing your
video—after you are logged in to the Internet Archive. Phil
missed seeing that link and added a public comment to his
video to add some extra information he forgot to include.

If you have ideas for some group video projects that VMUG
members can work on, you might bring them to the VMUG
Multimedia special interest group (SIG.) See the Multimedia
SIG blog for further information.

http:/fweb.mac.com/haly2k1/iWeb/Site/Blog/Blog. html

Are you curious to learn a bit more about Brewster Kahle, the
visionary who created the Internet Archive? Search for his
name in the Internet Archive. You can view a video of a speech
he gave at the Library of Congress in December, 2004. (Scroll
down about 5 items in the search results.)

If Brewster Kahle has given the world this immense gift, what’s
the most appropriate way of thanking him? Use the gift.

Phil Shapiro pshapiro@his.com
hitp:/fwww.digitaldivide. net/profile/pshapiro
http:/ldigg.com/users/pshapiro/submitted
hitp:/fwww. his.com/pshapiro/stories.menu. html

i Mac User Grour 12



